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Documentation Updates

The title page of this document contains the following identifying information:
® Software Version number, which indicates the software version.
® Document Release Date, which changes each time the document is updated.
® Software Release Date, which indicates the release date of this version of the software.
To check for recent updates or to verify that you are using the most recent edition of a document, go to: http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html|
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage
your business. As a valued support customer, you can benefit by using the support web site to:

®  Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your
business needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp
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Welcome

This guide provides information for setting up and configuring the Service Asset and Configuration
Management (SACM) solution. This guide outlines the integration between HP Asset Manager,

HP Universal CMDB, and HP Service Manager. It explains how to install and configure the
components of the integration, as well as outlining how functionality of the integrated applications is
enhanced.

This chapter includes:
e "How This Guide is Organized" below
e "Who Should Read This Guide" on the next page

o "Additional Online Resources" on page 12

How This Guide is Organized

This guide contains the following chapters:
Chapter 1 Introduction to SACM

In addition to providing an overview of the Service Asset and Configuration Management Solution,
provides an introduction to SACM integrations and briefly describes how the following products
work with each other:

HP Service Manager (SM)

e HP Universal CMDB (UCMDB)
o HP Asset Manager (AM)
e HP Connect-It (CIT

Chapter 2 HP Service Manager and HP Universal CMDB Integration

Provides the installation and configuration steps required to configure and verify the integration
between Service Manager and Universal CMDB .

Chapter 3 Populating HP Universal CMDB from HP Asset Manager

Provides the installation and configuration steps required to configure and verify the integration of
HP Asset Manager to HP Universal CMDB, which involves taking configuration items (Cls) from
AM to populate UCMDB.

Chapter 4 Data Push from HP Universal CMDB to HP Asset Manager

Provides the installation and configuration steps required to configure and verify the integration
between HP Universal CMDB and HP Asset Manager, which involves taking Cls from UCMDB
and pushing them into AM.
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Chapter 5 HP Asset Manager and HP Service Manager Via CIT Integration

Provides the installation and configuration steps required to configure and verify the integration
between Asset Manager and Service Manager via CIT.

Chapter 6 HP Asset Manager Web Configuration

Provides the installation and configuration steps required to configure and verify the Asset
Manager Web Configuration.

Chapter 7 HP Service Manager and HP Asset Manager Integration

Provides the installation and configuration steps required to configure and verify the integration
between Service Manager and Asset Manager pursuant to a request from the catalog.

Chapter 8 Cl's Reconciliation Priority Best Practices

Provides the Best Practices guidelines and configuration instructions for how to prioritize the
information received from Asset Manager and Service Manager into UCMDB in order for UCMDB
to contain the most accurate Cl information.

Appendix A: Technical Reference

Describes how data objects are sourced and mapped by which scenario or adapter, as well as the
reconciliation keys used, and any special requirements needed for data transfers to work properly

Who Should Read This Guide

This solution is intended for IT organizations that want to better manage all their assets from
procurement to decommissioning, all the while supplying both operational as well as IT Financial
Management data.

This guide is intended for:

o Customers

Presales and sales personnel
e PSO
« Anyone who wants to learn about the solution, its flow, and its value or the value it delivers

The information in this guide may duplicate information available in other SACM documentation, but
is provided here for convenience.
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Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on the HP Software
Support Web site where you can search the Self-solve knowledge base. Choose Help >
Troubleshooting & Knowledge Base. The URL for this Web site is
http://h20230.www?2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site enables you to
browse the Self-solve knowledge base. You can also post to and search user discussion forums,
submit support requests, download patches and updated documentation, and more. Choose Help
> HP Software Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract.

To find more information about access levels, go to:
http://h20230.www?2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:
http://h20229.www2.hp.com/passport-registration.html.

HP Software Web site accesses the HP Software Web site. This site provides you with the most
up-to-date information on HP Software products. This includes new software releases, seminars
and trade shows, customer support, and more. Choose Help > HP Software Web site. The URL
for this Web site is www.hp.com/go/software.

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This
site enables you to explore HP Product Solutions to meet your business needs, includes a full list of
Integrations between HP Products, as well as alisting of ITIL Processes. The URL for this Web
site is http://support.openview.hp.com/sc/solutions/index.jsp.
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Introduction to SACM

This chapter includes:

Service Asset and Configuration Management —Overview _...................................... 13
SACM 9.30 Solution Diagram ...l 17
Hardware and Software Requirements ... 18
SACM Project Planning . ... . 28
HP Asset Manager — OVerVieW ... e 29
HP Service Manager —OVerview ... .. ..o i 30
HP Universal CMDB — OVerview il 30
HP Connect-it — Overview ... .. . 31

Note: If you have any feedback or comments, please contact
solutionpackagingandscp@hp.com.

Service Asset and Configuration Management -
Overview

SACM provides a necessary data foundation that is core to operating IT. This enables the business
to function within its own constraints while taking into account the unique needs of the business.
Many key IT (ITIL) processes rely on SACM being in place in the organization; including all of the
following:

Service Portfolio Management (Service Strategy)
IT Financial Management (Service Strategy)
Service Level Management (Service Design)
Incident Management (Service Operations)
Problem Management (Service Operations)
Request Management (Service Operations)
Configuration Management (Service Transition)

Change Management (Service Transition)
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By enabling and supporting these processes, SACM contributes to:
o Planning and proactive management of IT to support the needs of the business.

o Financial traceability—the ability to understand where the IT budget is being spent and in
support of which business drivers
This also supports better financial decision making in general and specifically determining if the
IT budget is truly supporting the important business services that drive the company’s revenue
stream.

« Maintaining appropriate service levels to support the business adequately IT should not over-
deliver, which is expensive and wasteful, or under-deliver, which inhibits the business from
producing better results. SACM provides the data points and transparency to more accurately
meet business needs.

o Enabling services to be operated effectively and efficiently

o Populating and managing the Configuration Management Database (CMDB )—discovering and
recording all the relevant components that comprise the IT environment

o Providing a process for on-boarding Assets and Cls—managing them throughout their
respective life cycles and retiring them in an organized manner to minimize the negative impact
on the business

« Improving the understanding of the complex interdependencies between the various
components of IT and reducing the negative impact they may have on each other

o Standardizing IT environments, resulting in reducing maintenance costs and improving
consistency and predictability of IT outcomes

SACM provides these values to the business throughout the entire service life cycle, from request
through procurement to deployment into the IT environment, management of the service in
production, and ending at the retirement and disposal phases. SACM is responsible for creating and
managing the Configuration Management System (CMS) and as such provides IT organizations
with more control over their IT environments, better adherence to the policies it defines, and greater
accessibility to the necessary information. SACM does so by delivering the following:

« Management and planning: Designing what level of configuration management is needed and
how this level will be achieved

« Configuration identification: Establishing a system of classification of Configuration Items (Cls)
into types, defining the relevant attributes for each Cl type, determining the key attributes and
the relationships between the various Cl types

o Configuration Control: Governing the addition, removal and updating of each Cl and ensuring
that the appropriate process and procedures are followed for each such activity

e Status accounting and reporting: Providing an accurate account of the status of each Cl/Asset

o Verification and audit: Conducting periodical audits to ensure that there are no discrepancies
between the documented and/or desired state of the environment and the actual state
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Installing SACM Products

Before you can install and configure the integration, the SACM products must be installed and
accessible by the integration components via the network.

In-depth knowledge and administration privileges to each of the following integration products are
required to install, configure and manage the integration successfully.

o HP Asset Manager

e HP Universal CMDB and its probe
o HP Service Manager

¢ HP Connect-It

o HP Service Manager <-> HP Universal CMDB integration (reuse the Cl Types that are mapped
from UCMDB to SM)

Note: The HP Universal CMDB to HP Service Manager Integration Guide to the SM <->
UCMDB integration is provided with SM.

You can access the guide through the SM Help Server.

Refer to the installation guides provided with each of the products that represent the SACM
solution.

Note: Although not in the scope of the SACM solution, integrating AM with IT infrastructure
discovery tools such as HP Discovery and Dependency Mapping Inventory can complement
the SACM solution by providing accurate, up-to-date inventory data which serves as the
foundation of the SACM solution. It is suggested to implement this integration before installing
and configuring the SACM solution.

Refer to the AM support matrix for the supported versions of various discovery tools. Refer to
the documentation provided with the discovery tools for integration information.
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SACM Prerequisites
This guide expects that the following products are installed and fully functional:

e HP Universal CMDB (UCMDB): Server should be installed. Data flow probe should be
connected and running.

o HP Service Manager (SM): Server, Client, Help Server, Web Tier, and Content Pack 10 should
be installed and running.

+ HP Asset Manager (AM): Application designer, client, and AM web application.

¢ HP Connect-lt: Scenarios from SACM 9.30 kit.

Note: This guide assumes that the SACM products are installed in the following default
locations:

e Universal CMDB — C:\hp\UCMDB\
¢ Service Manager — C:\Program Files\HP\Service Manager 9.30
o Asset Manager — C:\Program Files\HP\Asset Manager 9.31 en

e HP Connect-It — C:\Program Files\HP\Connect-It 9.40 en
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SACM 9.30 Solution Diagram

The following diagram displays a typical deployment of the SACM Solution.

616 (Push)-
Infrastructure Cls, |
Business Services, APls
_ Applications,
307 (Population)- SW Installs & GPA
AM Portfolio liems Utilization
GDEBA Based)
- L2 001
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AMDE
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Universal
Discovery (UD)
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Integration Name

Employee Self-Service Catalog for Asset Manager (AM - SM)

Reference Data Synchronization via Connect-It (AM <-> SM)

Inventory, Software Utilization and Business Data Synch (UCMDB to AM)
Asset to Cl Replication (AM -> UCMDB)

Cl sync and actual state federation (UCMDB to SM)
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Hardware and Software Requirements

The instructions in this document assume that products are installed in the default location. If this is

not the case, you will need to make the appropriate modifications to file paths mentioned in this

document.

This section also includes:

SUPPOEd VerSIONS 18
Hardware and Software Requirements ... .. 18
Supported Versions
The following product versions were validated for the SACM 9.30 solution:
Product Version Instructions
UCMDB | 10.01 orlater For installation instructions, see the HP Universal
CMDB Deployment Guide.
Recommended: 10.01
Service | 9.30 with patch 6 and AP3 or For installation instructions, see the HP Service
Manager later Manager Interactive Upgrade Guide
Recommended: 9.30 with
service pack 7
Connect-  9.40 or later For installation instructions, see the HP Connect-
It IT Connector Guide.
Recommended: 9.40
Asset 9.31 or later For installation instructions, see the
Manager . HP Asset Manager Installation and Upgrade.
Recommended: 9.31 with the
SACM 9.30 content pack
Note: Make sure that each application you install is up and running before you perform any
configuration steps.
Hardware and Software Requirements
This section includes:
HP Asset Manager ReqUIremMents ... .. i 19

HP Service Manager Requirements ... ..
HP Universal CMDB Requirements ... il

HP Connect-it Requirements ...

Page 18 of 92


http://support.openview.hp.com/selfsolve/document/KM00245441?searchIdentifier=-4feeec50%3a13bb1a887c1%3a-634f&resultType=document&documentURL=KM00245441&resultsURL=%2fselfsolve%2fmanuals&allowReturn=false&searchString=&searchKey=2012-12-19+08%3a02%3a39
http://support.openview.hp.com/selfsolve/document/KM1195774/binary/SM9.30_Interactive_Upgrade_Guide.html?searchIdentifier=-72890797%3a1396613d536%3a-3dc1&resultType=document
http://support.openview.hp.com/selfsolve/document/KM1341322/binary/CIT9.40_ConnectorGuide_en.pdf?searchIdentifier=56546fde%3a137963714b8%3a-2b65&resultType=document
http://support.openview.hp.com/selfsolve/document/KM1137187/binary/AM930-Installation-EN.pdf?searchIdentifier=56546fde%3a137963714b8%3a-2a2c&resultType=document

Configuration Guide
Introduction to SACM

HP Asset Manager Requirements

Recommendations

Asset Manager Client Programs

The Asset Manager client programs support:
o Windows
o Unix

To find out what operating system versions are supported, consult
the Support Matrix at: www.hp.com/go/hpsoftwaresupport.

Asset Manager Database Server

The server may be used with all the operating systems and
hardware platforms supported by your DBMS.

To acquire the list of these supported items, refer to the
documentation of your DBMS.

Minimal and recommended system configuration in
Windows

Minimal configuration

o All programs except Asset Manager Automated Process
Manager and Asset Manager Web and Asset Manager
Web Service

Windows XP Windows Vista,
and Server Windows 7 and

Environment 2003 Windows Server 2008
CPU Intel Xeon or Intel Xeon or equivalent
equivalent
RAM 1GB 2GB
Disk space 4 GB (all 4 GB (all packages
(*) packages installed)
installed)

(*) The files installed with Asset Manager require about 700 MB
disk space (excluding production database and client database
layers).
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Recommendations o Asset Manager Automated Process Manager

Environment Windows Server 2003 and Server 2008
CPU Intel Xeon dual-core or equivalent

RAM 1 GB reserved for Asset Manager
Automated Process Manager

Disk space 4GB

Recommended configuration
e All programs except Asset Manager Automated Process

Manager and Asset Manager Web and Asset Manager
Web Service

Windows XP Windows Vista,

and Server Windows 7 and
Environment 2003 Windows Server 2008
CPU Intel Xeon Intel Xeon or equivalent
dual-core or
equivalent
RAM 2GB 2GB
Disk space 4 GB (all 4 GB (all packages
*) packages installed)
installed)

(*) The files installed with AM (client only) require about 350 MB
disk space (excluding production database and database
layers).

o Asset Manager Automated Process Manager

Environment Windows Server 2003 and Server 2008
CPU Intel Xeon quad-core or equivalent

RAM 2 GB reserved for Asset Manager
Automated Process Manager

Disk space 4GB

Network High speed link with DBMS server. (For
example, Ethernet 100 Mbps or Gigabit)
and low latency (<5 ms).

Page 20 of 92



Configuration Guide
Introduction to SACM

Recommendations o Asset Manager Web

For details of the configuration needed to support AM Web, see
the AM 5.20 Sizing Guide Using Oracle DB2 or MSSQL.
This White Paper is delivered in the locations indicated in the
Release Notes, Related documentation chapter, Asset
Manager reference documents/ White papers section.

Supported DBMSs

The following DBMSs are supported for the AM database:
o Microsoft SQL Server

¢ Oracle Database Server

« IBMDB2UDB

To find out what DBMS versions are supported (servers, clients,
network protocols, drivers, etc.) consult the Support Matrix at:

www.hp.com/go/hpsoftwaresupport.

Warning: We do not guarantee the proper functioning of AM with
versions (even later versions) or Service Packs different from
those described in the Support Matrix.

Warning: We do not guarantee the proper functioning of AM with
versions or Service Packs that are no longer supported by their
respective vendors.
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HP Service Manager Requirements

Recommendations

Service Manager Server

o X86-64 Server

Operating Systems

o Windows 2008+

o Red Hat Enterprise Linux 5.4+

For more supported platforms, refer to the product compatibility
guide.

RDBMS
e Oracle 11.1
e Oracle 11.2

For more details about supported RDBMS, refer to the product
compatibility guide.

Service Manager Client

Operating Systems:

¢ Windows XP

o Windows Vista

e Windows 7

Service Manager Web Tier
o X86-64 Server
Operating Systems:

e Windows 2008+

o RedHat Enterprise Linux 5.4+
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Recommendations Application Server
e Apache Tomcat 5.5.33
e Apache Tomcat 6.0
Web Server:
o Apache Web Server 2.2

For more details about supported Web and Application
Servers, refer to the product compatibility guide.
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HP Universal CMDB Requirements

Recommendations

Server Software Requirements:

Hardware Platform: x86-64

o Recommended: Windows 2008: Enterprise SP2, R2, and
R2 SP1 64-bit

¢ Windows 2008: Standard R2 and R2 SP1 64-bit
e RedHat Linux 5.x: Enterprise/Advanced 64-bit
o Red Hat Enterprise Linux Server 6.2 and higher: 64-bit

Computer/processor

Windows/Linux: To fulfill the CPU requirements,you must
have one of the following:

o Intel Dual Core Xeon Processor 2.4 GHz or later
e AMD Opteron Dual Core Processor 2.4 GHz or later

In addition to the above requirements, you must have the
following number of CPU Cores, depending on your
deployment configuration:

o Small deployment: 1 CPU
o Standard deployment: 4 CPUs
o Enterprise deployment: 8 CPUs

Note: As UCMDB performance is dependent upon processor
speed, to ensure proper UCMDB performance, it is
recommended that you use the fastest possible processor
speed.

Memory:

For Windows/Linux:
o Small deployment: 4 GB RAM
o Standard deployment: 8 GB RAM

o Enterprise deployment: 16 GB RAM
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Recommendations

Note:

Memory swap file:

For Windows:

« Small deployment: 6 GB (Supported)
« Standard deployment: 12 GB

o Enterprise deployment: 24 GB

For Linux:

« Small deployment: 4 GB (Supported)
« Standard deployment: 8 GB

o Enterprise deployment: 16 GB

Note:

o The virtual memory for Windows should be at least 1.5
times the size of the physical memory.

e The Linux swap file size should be equal in size to the
physical memory.

Free hard disk space
¢ Minimum 30 GB (for logs, memory dumps, and so on)
Display: Windows

o Color palette setting of at least 256 colors (recommended:
32,000 colors

e Windows 2003 is no longer supported in UCMDB 10.00.

¢ Installation of UCMDB is not supported on 32-bit machines.
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HP Connect-it Requirements

Recommendations Hardware

o Windows configuration
» CPU: Dual-core 2 GHz
= RAM:2GB

o Unix configuration
= CPU: Dual-core 2 GHz
= RAM:2GB

Operating Systems

¢ Solaris 9
= conitsvc: 7 MB
= cntrsrv: 8 MB

« HP-UX
= conitsvc: 7 MB
= cntrsrv: 6 MB

o AIX 5.1
= conitsvc: 4 MB
= cntrsrv: 5 MB

e Linux
= conitsvc: 6 MB

= cntrsrv: 7 MB
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Recommendations o Web server
Tomcat: 256 VIB

= Memory for conitsvc depends on the size of the
documents processed.

n Forcntrsrv: the memory used by a Java connector may be
greater than indicated because of the Java Virtual
Machine.

= Memory for DLL files required by the connector must be
added to the given memory size.
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SACM Project Planning

HP Service Asset and Configuration Management

The various tasks that must be done in order to use the SACM solution appear in the following
diagram:

SACM 9.30

Installation & Contiguration timeline

>
Freparation Installation Configuration Werification

L4 bl e d e d
Make sure all

prerequisites are

met

Shy installation
—_—

UCHDB installation
>

S - UCMDB Integration Configuration

Shi - LICMDE Integration Verification

Add Irstorllation
—_—

A - UCMEB Integration Configuration

Add - LCWMOB Integration Werification

Adh — Sh via CIT Integration Configuration

At — Sh vien CIT Integration Yerification

Sht — Ad Integration Configuration

Shi — A Integration Yerification

Solution Werification

Werify the entire Lse case
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HP Asset Manager — Overview

HP Asset Manager (AM) helps IT organizations minimize their compliance risk, effectively manage
their IT services, and maximize the utilization of IT.

AM supports the life cycle management of physical and logical assets. AM’s modules—Asset
Tracking, IT Procurement, Contract Management, Software Asset Management and Financial
Management—will ensure that IT organizations get full visibility on their portfolio and can smoothly
run operations and optimize their use of IT.

AM's main benefits are described as follows:
o Asset Tracking:
= Track and manage fiscally relevant physical and virtual assets throughout their life cycle
= Optimize IT spending
= Reduce the number of lost and unused assets
= Improve IT governance
¢ IT Procurement:
= Streamline IT procurement life cycle process
= Optimize purchase costs by tracking vendor prices
= Manage approvals and fulfillment of requests
= Measure contract objectives against vendor delivery metrics
¢ Contract Management:
= Automatically manage the operational state of contracts in use
= Track compliance with vendor terms and conditions
= Link assets to contracts (purchase, leasing, maintenance, support contracts)
= Monitor and re-evaluate contracts and suppliers
= Optimize cost of IT contracts
+ Software Asset Management (SAM):
= Ensure vendor software license compliance using out-of-the-box SAM best practices

= Allow organizations to optimize what is already owned
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= Enable active management for the authoritative state of software Cls
« IT Financial Management:

= Track cost of assets and business services

= Define service offerings, manage user subscriptions

= Support showback/chargeback for use of business services

= Execute Budget Management Best Practices

HP Service Manager - Overview

HP Service Manager stores the managed or expected state of Cls and Cl relationships as attribute
values in a Cl record. To be part of the integration, a Cl attribute in your UCMDB system must map
to a managed field in the SM ClI record. You can add, remove, or update the managed fields that are
part of the integration by tailoring the SM Web services that manage the integration.

SM runs according to a set of rules that define what actions you want the system to take whenever
a Cl’s actual state does not match the expected state as defined in the Cl record. You define these
rules from the Discovery Event Manager (DEM) in SM where you can do the following:

« Automatically update a Cl record to match the attribute values listed in the actual state. (This is
the default behavior.)

« Automatically create a change record to review the differences between the actual state and the
managed state.

o Automatically create an incident record to review the differences between the actual state and
the managed state.

HP Universal CMDB - Overview

HP Universal CMDB (UCMDB) consists of a rich business-service-oriented data model with built-
in discovery of configuration items (Cls) and configuration item dependencies, visualization and
mapping of business services, and tracking of configuration changes.

UCMDB implements data model, data flow management, and data modeling capabilities, and also
provides impact analysis, change tracking, and reporting capabilities to transform CMDB data into
comprehensible, actionable information that helps answer critical questions and solve business
problems.
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HP Connect-it — Overview

Connect-It is an Enterprise Application Integration (EAI) type integration platform. An EAI solution
enables a company to integrate the different applications from which it can obtain or to which it can
provide internal data (Internal support, equipment management software, and so on) or external
data (ERP, B2B, B2C). Connect-It integrates not only data, but also a company's application
processes.

You can use Connect-lIt to:

Transfer information from one database to another.

Duplicate the information from one database to another in real-time.

o Import information from e-mails, delimited text files, XML files or other formats into a database.

Export information from a database to e-mails, delimited text files, XML files or other formats.

Import NT Security-based information into a database.
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Integration

This chapter includes:

OV IV W L 32

Create aNew Integration Point ... 32

Set Up SM for Integration with UCMDB ... ... .. 34
Overview

This chapter describes the necessary steps to configure and verify the integration between SM and
UCMDB and uses an out-of-the box configuration where a default set of configuration items (Cls)
and their relations are synchronized between UCMDB and Service Manager.

Create a New Integration Point

1. Logonto UCMDB as an administrator.

2. From the left-hand navigation pane, select Data Flow Management > Integration Studio.

3. Inthe Integration Point pane, click the New Integration Point |_| button. The New Integration
Point dialog box opens.

Enter the following information:

Name Recommended Value Description
Integration Name SM Integration The name you give to the integration point.
Adapter <user defined> Select the appropriate adapter for the version

of SM you are using.

Is Integration selected Select this check box to create an active
Activated integration point.

4. Inthe Adapter Properties fields, fill in the relevant details.

Name Recommended Value Description

Hostname/IP <user defined> The name of the SM server.
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Name Recommended Value Description
Port <user defined> The port through which you access SM.
Credentials  <user defined> If SM credentials appear in the Credentials

column, select them.

If no SM credentials appear, select Generic
Protocol and click the Add new connection

details for selected protocol type % button.
Enter the following information:
= Description. Enter Service Manager.

= User Name. Enter the Service Manager user
name. The default value is falcon.

= User Password. Enter and confirm a
password.

Probe Name @ <user defined> Select the name of the Data Flow Probe used to
run population jobs.

5. Click Test Connection.
6. After the connection success message appears, click OK.

7. Onthe Federation tab, select the Incident, Problem, and RequestForChange CI types and

click the Save Integration Point J button.
8. Logontothe JMX console.
9. From the UCMDB section, select UCMDB:service=Multiple CMDB Instances Services.
10. Invoke:
= setAsGloballdGenerator and verify it succeeded.

= getGloballdGeneratorScopes and verify it succeeded.
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Set Up SM for Integration with UCMDB

This task includes:

Add the UCMDB Connection Information to the System Information Record ................... 34
Run the Data Push Jobs

Run the Population Jobs

Add the UCMDB Connection Information to the System
Information Record

1.

2.

6.

Log on to your SM system as an administrator.

From the System Navigator, select System Administration > Base System Configuration
> Miscellaneous > System Information Record.

Click the Active Integrations tab.

Select the HP Universal CMDB option. The form displays the UCMDB Web service field
URL.

Inthe UCMDB Web service URL field, enter the URL to the UCMDB Web service API. The
URL has the following format:

http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService.

In the Userld dialog box, enter your UCMDB user name and password and click Save.

Run the Data Push Jobs

Note: To verify that Data Push is working, find a Cl in UCMDB that does not appear in SM.

—_

Log onto UCMDB.
From the left-hand navigation pane, select Data Flow Management > Integration Studio.
In the Integration Point pane, click the correct integration.

Click the Data Push tab. The Job Definition pane appears.

=
L

Select your job and click the Run Job — Sync All Data button to run the replication job.

When the Confirm synchronizing window appears, click Yes.
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7. Click the Refresh 2 button and wait until the Succeeded message appears in the Status
tab. The updated synchronization status appears.

8. Browse to your SM server.

9. From the System Navigator, select Configuration Management > Resources > Search
Cls.

10. Click Search % and verify that all the Cls from UCMDB are listed in SM.
11. Double-click one ClI that is replicated from UCMDB.
12. Drill down to the Actual State section and verify that all parameters are OK.

13. Click View in UCMDB and verify that UCMDB opens and you can view the CI.

Run the Population Jobs

Note: To verify that population is working, create a new Cl in SM.

1. Logonto UCMDB.

2. From the left-hand navigation pane, select Data Flow Management > Integration Studio.

3. Inthe Integration Point pane, click the correct integration.

4. Click the Population tab.

5. Select the SM Configuration Items Population job and click the Run Job — Sync All Data
5 button to run the population job.

6. When the Confirm synchronizing window is displayed, click Yes.

7. Click the Refresh o button and wait until the Succeeded message appears in the Status
tab. The updated synchronization status appears.

8. Take the same action with the SM Relations Population job.

9. Logonto UCMDB and validate that the Cl that was created in SM is validated in UCMDB.
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Manager

This chapter includes:

OV IV W . 36
Connect to the appropriate Asset Manager version ... ... 36
Configure Connection from UCMDB to AM ... . .. 37
Verify UCMDB to AM Configuration ... ... . 41

Overview

This section describes the necessary steps to configure and verify the integration between
UCMDB and AM as it comes out of the box, without customizing it to specific customer
requirements. In this integration, IT management-related assets are copied from AM to UCMDB.
Depending on the asset type, a Cl is created and assigned a unique Global ID.

Connect to the appropriate Asset Manager version

In order for the adapter to connect to the appropriate Asset Manager version, you must supply the
Data Flow Probe/Integration Service with the appropriate Asset Manager API DLLs and Jars. To do
this, follow these steps:

1. Copy the following files:
= <Asset Manager Installation folder>\x64\*.dl|

= <Asset Manager Installation folder>\websvc\lib\*.jar

2. Create a package called AMPushAdapterAPI_<AM Version Number>.zip. For example, for
version 9.3, the package is AMPushAdapterAPI_9.3.zip.

3. Paste the copied files to:

<AMPushAdapterAPI_{AM Version
Number}.zip>\discoveryResources\AMPushAdapter\amVersion\<AM Version Number>

For example, for version 9.3, the path is:
AMPushAdapterAPI1_9.3.zip\discoveryResources\AMPushAdapter\amVersion\9.3

4. Deploy the AMPushAdapterAPI_<AM Version Number>.zip package.
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Configure Connection from UCMDB to AM

Step 1: Get the adapter content package

1.

2.

Logonto UCMDB.

Browse to Data Flow Management > Adapter Management.
Expand AMAdapter from the resources list.

Expand External resources and select AMadapter/Content.zip.

Export to the local server and extract all files from Content.zip. The AMdatakit and
AMDBUpdate folders are displayed. AMdatakit is used to sync dtLastModif among amAsset,
amPortfolio, and amComputer tables.

Step 2: Import the workflow into AM

1.

2.

Log on to Asset Manager Client.

Select File > Import.

Click Execute a script.

Browse to the Content directory from Step 1—AMDataKit.
Select WF_SACM.scr.

Enter the password and click Import.

Confirm the imported workflow by clicking tools > workflow > workflow schemes and find
Update dtRecCreation.

Step 3: Create SQL views in the AM database

Caution: This batch file can only be used on Windows computers, not UNIX computers.

The batch file should be run from a computer where the client layers of the DBMS (for example,
Oracle Database 10g Client R2) used for the AM database are installed.

Running this batch file alters the AM database structure.

Administrative privileges are required at the DBMS level to create the SQL views.

1.

2.

Set the ORACLE_HOME environment variable.

Run the create view script.
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5.

a. Click start > Run.
b. Entercmd.

c. Enter sqlplus <schema name>/<schema password>@<SID_Hostname of oracle
server>,

d. Enter GRANT create ANY VIEW to <Username>.

e. Enter GRANT SELECT ANY TABLE to <Username>.

f. Enter GRANT create MATERIALIZED VIEW to <Username>.
g. Enter exit to exit Oracle.

Browse to the AMDBupdate folder.

If using an Oracle server, run the command CreateViews.bat Oracle <Oracle SID>
<Username> <Password>; for example, CreateViews.bat Oracle SSG_labm3amdb35
SACM4 topaz.

If using an SQL server, run the command CreateViews.bat [MSSQL2005|MSSQL2008]
<Server> <Database> <Username><Password>.

Confirm all views created in the AM database.

Step 4: Make some Cl attributes visible

1.

2.

5.

Open a browser and log on to the UCMDB Server as an administrator.
From the left navigation bar, select Modeling.

Select Cl Type Manager and select the Cl Type that contains the ClI attribute from the
navigation tree.

On the Attributes tab, double click the attribute you want to modify.

By default, the following CI attributes are not visible:

Cl Type Attribute

IpAddress IP Address
IPis DHCP

CPU CPU Speed

Select the Advanced tab, and select Visible.
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Step 5: Create an integration point

1.

2.

5.

Logonto UCMDB.

Browse to Data Flow Management > Integration Studio.

Click the New Integration Point| =l button.

In the New Integration Point dialog box, fill in the following Integration Properties.

Name Recommended Value Description

Integration AM population Name given to the integration

Name point.

Adapter AM Population and Federation Adapter to be used for the
Adapter 9.30 and later versions integration point.

Is Integration  selected Select checkbox to create an

Activated active integration point.

In the Adapter Properties, fill in the relevant details.

Recommended
Name Value Description

Hostname/lP = <user defined> Enter the hostname or IP address of the database server.
For SQL Server with instance name, enter
<hostname>\<instance name>

Port <user defined>  Enter the database port default port for Oracle 1521 and
SQL 1433.

Credentials  <userdefined> @ Click the Add new connection details for selected

ID
protocol type |"=“| button.

Enter the following information:
= Forthe AM User Name, enter Admin.

= Forthe AM password, enter the password of the AM
log on.

= Forthe database user name, enter the name of the
schema.

» Forthe database password, enter the password of the
schema.
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Recommended
Name Value Description
DB <userdefined> | Enterthe database name. For Oracle, enter a service
Name/SID name instead of the SID.
DB Type <userdefined> | Select on of the following the database types:
= Mysql
= Oracle
= SQL
Push Back Enabled Identify a unique CI if the feature is disabled and the
IDs reconciliation of Cls will not work.
Version <userdefined>  Version of Asset Manager to access
Data Flow <user defined> | Select the correct Probe from the drop-down list.

Probe

6. Click Test connection and OK.
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Verify UCMDB to AM Configuration

Note: On first use, run the full population job. After any changes are made, only run the diff
population job.

In order to verify Asset Manager to UCMDB Population flow, we create an Asset in Asset Manager,
and verify it is synchronized as a configuration item in UCMDB.

1.

2.

10.

1.

12.

13.

Log on to Asset Manager.

Create a new virtual machine in the IT equipment module, specifying its name and IT
equipment type (in our case, Virtual Machine).

In the Assets view, add the serial number.

Logonto UCMDB.

Browse to Data Flow Management > Integration Studio.
Select the AM Population integration point.

In the Integration Jobs pane, select the Population tab and click the AM Population job.

&

Click the Run Job — Sync All Data button.

When the Confirm synchronizing window appears, click Yes.

Click the Refresh & button and wait until the Succeeded message appears in the Status
tab. The updated synchronization status appears.

Browse to Modeling > IT Universe Manager.
Select the Search Cls tab and search for the name of the virtual machine specified in step 2.

Confirm that a corresponding Cl exists in UCMDB.

Note: Note its name as it will be used in the next section.

Page 41 of 92



Data Push from HP Universal CMDB to
HP Asset Manager

This chapter includes:

OV IV W L 42

Configure Connection from AMto UCMDB ... .. 42

Verify AM to UCMDB Configuration ... ... .. 44

Troubleshooting .. ... . 46
Overview

This section describes the necessary steps to configure and verify the integration between
UCMDB and AM as it comes out of the box, without customizing it to specific customer
requirements. This involves taking configuration items (Cls) from UCMDB and pushing them into
AM.

Configure Connection from AM to UCMDB

1.

2.

Log onto UCMDB.

From the left-hand navigation pane, select Data Flow Management > Integration Studio.

In the Integration Point pane, click the New Integration Point |_| button. The New Integration
Point dialog box opens.

Enter the following information:

Recommended
Name Value Description

Integration Name =AM Push Integration The name you give to the integration point.

Adapter Asset Manager Push | Select the Push adapter.

Adapter
Is Integration selected Select this check box to create an active
Activated integration point.
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4. Click the Adapter 1 icon to open Content Help for this adapter.

a. Navigate to HP Universal CMDB Discovery and Integration Content Guide >
Integrations > HP Asset Manager Push Integration > How to Integrate UCMDB and
Asset Manager > Set Up UCMDB.

b. Follow the steps provided.

5. Inthe Adapter Properties fields, fill in the relevant details.

Name

Hostname/IP

DB Type

Port

DB
Name/SID

Credentials
ID

AM Version

Other
Connection
Options

Recommended

Value

<user defined>

<user defined>

<user defined>

<user defined>

<user defined>

<user defined>

<user defined>

Description

Type the hostname or the IP address of the database
server. For SQL Server with instance name, type
<hostname>\<instance name>.

Select the database type: Oracle, DB2 or MSSQL.

Type the DB port default port for Oracle 1521, DB2
50000, and SQL Server 1433.

Enter the database name. For Oracle, enter a Service
Name instead of an SID.

Click the Add new connection details for selected
protocol type || button.

Enter the following information:

» Select the database type.

Type the port number.

In User name, type the schema user of AM.

= InDB password, type the password of the schema. a
Select the Asset Manager version.

Allow you to set additional AM DB connection
parameters. You can leave the field empty or add some
AM DB connection parameters split with a semicolon.

For examples: FetchingArraySize=150;Stmtcache=100
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Recommended
Name Value Description
Enable <userdefined> | Select TRUE if you want to push data in multiple
Parallel processes.
Push
Data Flow <userdefined> | Select the right Probe from the drill down list.
Probe

6. Click Test Connection and OK.
Verify AM to UCMDB Configuration

Note: On first use, run the full push job. After any changes are made, only run the diff push job.

1. Logonto UCMDB.
2. From the left-hand navigation pane, select Data Flow Management > Integration Studio.
3. Select the AM Push Integration adapter.

4. Inthe Integration Jobs, click the AM Push integration.

&

5. Click the Run Job - Sync All Data button.

6. When the Confirm synchronizing window appears, click Yes.

7. Click the Refresh & button and wait until the Succeeded message appears in the Status
tab. The updated synchronization status appears.

8. Make sure that Cls from UCMDB appear in Asset Manager. For example:
a. InUCMDB, in the left-hand navigation pane, select Modeling > Modeling Studio, expand
Root from the resources list, expand Integration / AM Push, double-click AM Computer
Push, in the opened Query Definition, right-click Root, and then select Show element
Instances.

b. Open the Asset Manager client, in the navigation panel, select Portfolio management >
Asset configurations > IT equipment > IT equipment.

c. Right-click the IT equipment list and select Simple filter, select IP Name=, type the
value that equals to the Display Label value in UCMDB, and then click search.

d. Make sure that all Cls from UCMDB appear in Asset Manager.
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Note: If Universal Discovery is used with Discovery Agent (previous functionality enabled by
the DDMi product), UCMDB will push alot of details about Cls into Asset Manager.
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Troubleshooting

This section includes:

When UCMDB fails to push updated Cls/Assets to Asset Manager and displays an error ... .. 46

When UCMDB fails to push updated Cls/Assets to
Asset Manager and displays an error

When HP Universal CMDB (UCMDB) fails to push updated Cls/Assets to HP Asset Manager (AM)
and displays an error that contains this reference:

Caused by: com.peregrine.ac.AmException: Error (12,001): ODBC error: [Micros
oft][ODBC SQL Server Driver][SQL Server]Snapshot isolation transaction abort
ed due to update conflict. You cannot use snapshot isolation to access table
'dbo.amCounter' directly or indirectly in database 'AM932 BT081' to update,
delete, or insert the row that has been modified or deleted by another trans
action. Retry the transaction or change the isolation level for the update/d
elete statement. SQLSTate: 37000 ('Line 1 of script ''Default value' of field
'Reference (Ref)' in table 'Workflow instances (amWfInstance)''')

SQL statement 'execute up_GetCounterVal N'amWfInstance_Ref', 1' could not be
executed ('Line 1 of script ''Default value' of field 'Reference (Ref)' in t
able 'Workflow instances (amWfInstance)''')

Counter 'amWfInstance_ Ref' unknown ('Line 1 of script ''Default value' of fi
eld 'Reference (Ref)' in table 'Workflow instances (amWfInstance)''')

Agent 'CWorkEvtAgent' returned error : '12001°'

An integrity was not correctly applied (no additional information available).
the cause of this error is a wrong counter setting in Asset Manager.
Toresolve this:
1. Start the Asset Manager Windows client.
2. Select File > Import.
3. Click the Execute a script button.
4. Select and import the <AM installation folder>/datakit/standard/counters.scr file.

5. After the import is finished, retry UCMDB > AM push.
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Via CIT Integration

This chapter includes:

OV IV W . 47
Integrating AM with SM Via CIT . ... 48
Add the SACM Integration Web Service .. ... . .. 49
Disable Contacts Synchronization ... . .. 50
Verify AM to SM Configuration ... ... 51

Overview

This chapter describes the necessary steps to configure and verify the integration between AM and
SM via HP Connect-It (CIT). This integration sets up the synchronization of reference data between
SM and AM. This data includes information about People, Places, Things (not Cls), commonly
referred to as PPT in the description described in this chapter. Depending on the current customer
implementation phase, the master data source can be either Service Manager or Asset Manager—
or each product will contain master data for specific record types.

By default, the provided HP Connect-It scenarios transfer the same PPT types from AM to SM and
from SM to AM. You cannot implement the scenarios as they are, because data replication would
circle back and forth. Thus you must decide whether the AM or SM database will store the
reference data for each of the PPT types:

Companies
Vendors
Locations
Departments
Contacts
Models

Stock rooms
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Integrating AM with SM Via CIT

1. Install CIT 9.40.

2. Download the SACM 9.30 content pack from HPLN
(https://hpln.hp.com/node/13253/attachment) and unzip it to C:\SACM-9.30.

3. Browseto C:\SACM-9.30.
4. Select one of the following scenarios:
» If the reference database for all PPT types is AM:
o Use amsm-ppt.scn to transfer the PPTs from AM to SM.

o Do not use amsm-ci-ppt-link.scn because links between Cls and Contact, Model,
Vendor, Location and Department are managed by the amsm-ppt.scn scenario.

» If the reference database for all PPT types is SM:
o Use smam-ppt.scn to transfer the PPTs from AM to SM.
o Use smam-wo.scn to transfer changes and tasks.

» If the reference database for PPT types is a mixed solution between AM or SM according to
PPT type:

o Customize smam-ppt.scn so that PPTs referenced in SM are transferred to AM.
o Customize amsm-ppt.scn so that PPTs referenced in AM are transferred to SM.

o Do not use amsm-ci-ppt-link.scn because links between Cls and Contact, Model,
Vendor, Location and Department are managed by the amsm-ppt.scn scenario.

o Use smam-wo.scn to transfer changes and tasks.

5. Foreach scenario, define the AM details and SM details.

4

6. Afterall the details are defined in the components, click to run the scenario.
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Add the SACM Integration Web Service

The HP Connect-It scenarios depend on the SACM Integration Web Service. You need to add this
web service to SM:

1. Start the HP Service Manager client.

2. Select Menu Navigation-Tailoring-Database Manager in the navigation pane.

3. Right-click the screen in the right pane and select Import/Load.

4. Inthe File Name field, enter C:\SACM-9.30\datakit\sc\sm93\SACMintegration.unl.
5. Click Load FG.

6. Select Menu Navigation-Tailoring-Web Services-Web Service Configuration in the
navigation pane

7. Inthe Service Name field, enter SACM Integration.
8. Click Search.

Verify that you see a list of entries prefixed with SACM.
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Disable Contacts Synchronization

In an environment where an Employee Self Service (ESS) Catalog integration is planned (as
described in Chapter 7), it is necessary to disable Contact synchronization in order to prevent
possible data duplication.

To disable the synchronization of Contact records:
1. Open the amsm-ppt.scn Connect-It scenario.
2. Inthe Scenario diagram pane, select the Mapping box, and then select the Mappings tab.

3. Inthe Detail of the connector 'Mapping' pane, uncheck Creation of a contact and Update a
contact.

4. Save the changes and exit the scenario.
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Verify AM to SM Configuration

1. Log onto SM and open a new change request.
2. Browse to Changes > Open New Change.
3. Enterall relevant data and mandatory fields.
4. Click save.

5. LogontoCIT.

6. Use the scenario smam-wo.scn.

7. Fill the relevant parameters for each product.

8. Click Produce Now 4 .
9. LogontoAM.
10. Browse to Asset Lifecycle > Work Orders > Work Orders.

11. Confirm that AM received the change request .
Note: This out-of-the-box integration synchronizes all Change and Change Tasks records
from Service Manager to Asset Manager. In the production environment, the user may want to

limit the scope for specific Change categories. To achieve this, there is a need to modify the
sSmam-wo.sch scenario.
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This chapter includes:

Overview
Prerequisites
Implementing AM Automated Process Manager in Windows
Tomcat Configurations
AM Web Service package.properties Parameters
Update Archive File Using Deployment Script
Install AM Web Service

Overview

This section describes the necessary steps to configure and verify the AM Web Configuration. It is

described here since it is a prerequisite for the SM-AM integration described in Chapter 7.

Prerequisites

1. Install JDK 6 and configure the environment variable of the JAVA_HOME to JDK folder; for
example, C:\Program Files\Java\jdk1.6.0_24.

2. Install Apache Tomcat 6.0.32.
3. Inorder for some required libraries to be found by AM Web, make sure <Asset Manager

Installation folder>\bin and <Asset Manager Installation folder>\bin\x64 is in an
environment variable of Path.

Implementing AM Automated Process Manager in
Windows

—_

. Browse to Start > Run.
2. Type services.msc.

3. Select Asset Manager Automated Process Manager 9.3 and change the startup type to
automatic.

4. Click Start and OK.
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5. Browse to Start > Programs > HP > Asset Manager 9.31 en > Automated Process
Manager.

6. Click File connect to new database.

7. Select the relevant database and type the credentials.
Tomcat Configurations

Note: These configurations must to be done just for Tomcat 6.

1. Browse to C:\Program Files\Apache Software Foundation\Tomcat 6.0\bin.
2. Right click tomcatéw.exe and select open. The Apache Tomcat 6 Properties window appears.
3. Select the Java tab.

4. Inthe Java options window, insert the line -
Dsun.lang.ClassLoader.allowArraySyntax=true.

5. Click OK.

AM Web Service package.properties Parameters

Note: Before editing the property file, make sure to:
o Make a backup copy of the file.

o If your application server is started, stop it.

1. Browse to <Asset Manager Installation folder>\websvc.

2. Edit the parameters in the package.properties file.

Parameter Description Value

DB.engine The database engine that = For example, ORACLE
is used by this installation
of AM.

DB.datasource The name of the For example, labm3amdb35
database server.
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Parameter Description Value

DB.login The database engine log
on of AM schema.

DB.password The password of AM
schema.

DB.library.path The path to the aamapi93 = For example, C:\Program
library. Files\HP\Asset

Manager9.30xx\bin\aamapi93.dI

AssetManager.UserLogin AM userlogon tobe used @ Forexample, Admin

by the WebService.
AssetManager.UserPwd =AM Password log on to
be used by the
WebService.
encrypt When this parameter is

set to true, the user
needs to enter a
password in unencrypted
format.

Update Archive File Using Deployment Script
1. Click Start > Run.

2. Type cmd.

3. Browseto C:\Program Files\HP\Asset Manager 9.31 en\deploy.

>

Type the command deploy.bat ..\websvc\package.properties.

5. Type the command deploy.bat ..\webtier\ package.properties.

Install AM Web Service

1. Copy <Asset Manager installation folder>\websvc\AssetManagerWebService.war to
C:\Program Files\Apache Software Foundation\Tomcat6.0\webapps.

2. Browse to C:\Program Files\Apache Software Foundation\Tomcat 6.0\bin.
3. Right click tomcatéw.exe and select open. The Apache Tomcat 6 Properties window appears.

4. Select the Java tab.
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5. Insert the line -Djava.library.path= C:\Program Files\HP\Asset Manager 9.31 en\bin.

6. Start Apache Tomcat 6.

Test for AM Web Service Successful Deployment

1. Open Internet Explorer.

2. Browse to http://<Name of the Asset Manager Web Service
server>:8080/AssetManagerWebService.

3. Verify the following page appears:

Database
Baza: SACME
Lipa A

Warsign: B30 -« baikd B3ER

CE pathi  CiBvogram Files'HPASEe! Manager 5,31 anibnlesmapiad.dil
Conmection pool

B tha Lo

-
Single Sign-0n{S50) configuration

Basstthe 550 configuration
System information

Yava:  Varles 1.6.0_24

VM Vanded  Sus Maradyatema [ne
VM Varslen  1%.1-bO32

D51 Hama Windoss 20037
Vargige 3.3

Architechee  xBd

Exposed Web Services by version

If an error message appears; for example:

1. Browse to C:\Program Files\Apache Software Foundation\Tomcat
6.0\webapps\AssetManagerWebService\WEB-INF.

2. Search for AssetManager.DB.Name and check that only the name of the AM schemais
shown there.

LERV-BRACLEY>
<description-AssetManager Database name</descri prion:
<env-entry-name>AssetManager .DB . Hame </ env-entcy-name >
<env-entry-typerjava.lang.String</env-entcy-type>
<env=-entry-value>TEST</env-entry-value>

<fBnv=antry>
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This chapter includes:

OV IV W L 56

Integrating SM with AM Pursuant to Request from Catalog ... ... ................ 56

Verify SM to AM Configuration .. ... ... 60

Troubleshooting .. ...l 62
Overview

This chapter describes the necessary steps to configure and verify the integration between SM and
AM following a request from the catalog. This integration enables the Employee Self Service (ESS)
user of Service Manager to create a request which will be transferred to Asset Manager and will be
processed there until completion.

A typical request handled by this integration includes the procurement of new IT assets—such as
the purchase of a new laptop computer for an employee or a new server for a data center.

Integrating SM with AM Pursuant to Request from
Catalog

1. Runan SMclient.

2. Connect to the SM database.

3. Inthe browser, select Menus-Service Catalog-Approval Activities.

4. Select the first line of the General Approval table.

5. Click the Remove Approval Activity link.

6. Click Finish.

7. Select Menu Navigation-Tailoring-Database Dictionary in the navigation pane.
8. Enter svcDisplay in the File name field.

9. Select the descriptor entry in the table (first line of the table).

10. Click the New Field/Key button.
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1.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

27.

28.

29.

30.

31.

32.

Populate the Name field with the optionList value, the Type field with the character value, and
click OK.

Edit the optionList entry in the table to populate the SQL Name field with OPTIONLIST, SQL
Type with IMAGE, and SQL Table with m1.

Click OK.

Click SM Alters.

Select the descriptor entry in the table (first line of the table) again.
Click the New Field/Key button.

Populate the Name field with the optionOptions value, the Type field with the character value,
and click OK.

Edit the optionOptions entry in the table to populate the SQL Name field with
OPTIONOPTIONS, SQL Type with IMAGE, and SQL Table with m1.

Click OK.

Click SM Alters.

Select Menu Navigation — Tailoring- Database Manager in the navigation pane.

Right click the Database Manager screen and select Import/Load in the contextual menu.

In the File Name field, select the <Asset Manager Installation
folder>\esscat\sc\sm71\SCR42940.unl file.

Click the Load FG button.
Right click the Database Manager screen and select Import/Load in the contextual menu.

In the File Name field, select the <Asset Manager Installation
folder>\esscat\sc\sm71\QC8955.unl file.

Click the Load FG button.

Select Tailoring- Web Services- WSDL Configuration from the navigation bar.
In the Service Name field, enter ServiceCatalog.

Click Search.

Select the ServiceCatalog entry in the list of results.

In the details of the ServiceCatalogWeb service, select the Fields tab.
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33.

34.

35.

36.

37.

38.

39.

40.

41.

42.

43.

44,

45.

At the end of the list of fields, add a new entry with the following information:

» Field: detailedDescription

= Caption: DetailedDesc

n Type: StringType

Click Save and OK.

In the Service Name field, enter ServiceDesk.

Click Search.

Select the ServiceDesk entry in the list of results.

In the details of the ServiceDeskWeb service, select the Fields tab.

At the end of the list of fields, modify the resolution field with the following information:
= Caption: Resolution

= Type: StringType

In the same list, modify the resolution.code field with the following information:
= Caption: ResolutionCode

Connect to CIT.

Click File — open.

Browse to <HP Connect-It installation folder>\scenario\ac\ac93\esscat\.
Run the follow scenarios:

= users.scn

$S0.sCn

= categories.scn

catalogitems.scn

= status.scn
In the Scenario diagram window, modify the configuration of the SM Web Service connectors:

a. Right-click the SM Web Service connector(s) and select Configure connector.... The
Configure the connector wizard opens.
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46.

47.

48.

49.

50.

51.

52.

53.

54.

55.

56.

57.

58.

59.

b. Click Next.

c. Populate the Define the connection parameters page.

d. Click Finish.

Return to the Scenario diagram window and modify the configuration of the AM connector:
a. Right-click the AM connector and select Configure connector....
b. Click Next.

c. Populate the Define the connection parameters page.

d. Click Finish.

Save your changes (File/ Save menu).

Install apache-tomcat-6.0.35-windows.

Change the name of the folder to TomcatESS.

Browse to C:\TomcatESS\confiserver.xml.

Change the port to a different port of AssetManagerWebService; for example:7080.

<Connector port="7080" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8443" />

Deploy the ServiceCatalog.war to C:\TomcatESS\webapps.

Log on to SM.

Browse to Service Catalog/ Catalog Connectors menu.

Select the connector named Open a Standard Requestin AM.

On the Expressions tab, enter the hostname and port for the Esscat Web service.

Start the Tomcat configuration console (Start/Programs/Apache Tomcat 5.0/ Configure
TomcatWindows menu).

Select the Java tab.
Add the following line to the Java Options section:

s -XX:MaxPermSize=256m
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60.

61.

62.

63.

64.

65.

66.

67.

Quit the Tomcat configuration console.

Browse to Tailoring/Web Services/Run WSDL to JS in the system navigator panel.
Enter the URL for the WSDL of the AM Web Service proxy. The format is:
http://ProxyServer:8080/Service Catalog/wsdl/ServiceCatalog.wsdl

Click Proceed. A window with the new Java script corresponding to the Web Service Proxy is
displayed.

Click Replace. The following message appears:

Successful compilation of JavaScript function or expression.
Enter status in a SM command prompt.

Check that linker appears in the list.

If the linker scheduler already appears in the list, restart it:

a. Inthe Command column of the linker line, enter K.

b. Click the Execute Commands button.

o

Repeat this action until the linker line disappears.
d. Click the Start Scheduler button.

e. Double-click linker-startup in the list.

Verify SM to AM Configuration

1.

2.

Connect to SM with the following link: http://hostname of SM:8080/webtier-9.30/ess.do
Log on to SM with the user that you created in AM.

Click order from catalog from the left pane.

Choose the product that appears in the SM catalog.

Click Add to cart.

Click the Checkout link.

Click submit request.

Complete the purpose tab and select the Urgency.

Click Submit and OK.
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10. LogontoAM.
11. Browse to Asset Lifecycle — Procurement Lifecycle — Requests — purchase requests.

12. Find the request in the list. It should begin with ESS-SD XXX.
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Troubleshooting
This section includes:
If an error about undefined Resolution . . . ... 62
ESS Catalog Tomcat console displays errors about “PermGen space” ... ... ................... 62

If an error about undefined Resolution

Welcome to HP Service Asset and Configuration Management (SACM) Solution, the HP Web-
based solution for application life cycle management. Service Asset and Configuration
Management (SACM) Solution helps you organize and manage all phases of the application life

cycle management, including defining releases, specifying requirements, planning tests, executing
tests, and tracking defects.

ESS Catalog Tomcat console displays errors about
“PermGen space”

If the ESS catalog to the Asset Manager purchase request integration does not work, and ESS
Catalog Tomcat console displays errors about PermGen space, update the JVM memory
settings—such as adding this line to Tomcat/bin/catalina.bat:

set JAVA OPTS=%JAVA OPTS% %LOGGING CONFIG% -server -Xms512m -Xmx512m -
XX:PermSize=512M -XX:MaxPermSize=512M.
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This chapter includes:

OV IV W L 63

PrONtIES LOGIC ... 63

Cl ReconCiliation Prionity ... . 64
Overview

Inthe SACM Solution, as well as from the ITPS Suite perspective, UCMDB is the center CI
repository. As such, it is populated with Cl information from various HP and third-party products.
Therefore, UCMDB must decide which source is more reliable and which source has the most
accurate information.

UCMDB uses internal out-of-the-box reconciliation rules that make sure no duplications are created
and the Cl information is accurate. In addition, it also uses the Reconciliation Priority module that
gives the Configuration Manager the power to determine for UCMDB which integration points are
more reliable for which Cl Types or Attributes (for more information, see Chapter 10 Reconciliation
Priority in the HP UCMDB Data Flow Management Guide).

In the SACM Solution, UCMDB is populated with Cl information from two products — AM and SM.

This chapter details the Best Practice guidelines and configuration instructions for how to prioritize
the information received from AM and SM into UCMDB in order for your UCMDB to contain the
most accurate Cl information.

Priorities Logic

Consider the following when building the priorities detailed in the following Cl Reconciliation Priority
Mapping table:

o UCMDB DDMA discovery reflects reality by its capability and is the most reliable source of
information for discoverable CITs.

o Business services and applications information is most likely to be more accurate in SM as the
owner of the Service Catalog.

e There are CITs that are coming from AM or SM—but not both. Thus, if it is a discoverable CIT,
DDMA will get the highest priority, and AM or SM will get the lower priority. Otherwise, the
relevant product will get the priority. For example, for the Asset CIT, AM gets the highest
priority.
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Note: The following table of priorities is based only on CITs and Attributes that are supported
by the Out-of-the-Box (OOTB) population integration.

The CI Reconciliation Priority Mapping table maps the various CITs and attributes between the
three products—UCMDB, AM, and SM. The table also contains the necessary values to be defined
for each integration point using the following instructions.

AM sm Disocvery|  AM sm
Insset deviceasset N/A 100 300
[asset_tag AssetTag
/configurationitem/Busir 1t/servi il N/A Business Service/ 100 200}
name Business Service [clidentifier
/Configurationltem/BusinessElement/BusinsessApplication N/A Business Service/ 100 200
name ication Service __[Clidentifi
/Configurationitem/BusinessElement/Service/InfrastructureService N/A Business Service/ 100 200)
name Infrastructure service _|Clidentifier
[Configurationitem/InfrastructureElement/Location [amLocation N/A 100 200)
[name [Name
[location_type |LocationType
/Configurationitem/InfrastructureElement/Node host [Computer 300 100) 100)
name TcplpHostName N/A
serial_number AssetserialNo serialNo 300) 200) 100)
bios_serial_number N/A BIOSId
_os_name Operatingsys os
discovered_os version OSServicelevel osversion
memory_size IMemorySizeMb y
discovered_vendor N/A [Vendor 300) 200
node_role ComputerType cI-subType
[Configurationitem/InfrastructureElement/NetworkEntity/ipAddress ard [com 300) 100) 100
ip_isdhcp. bDHCPEnabled N/A
ip_address TeplpAddress N/A
ip_address_value ip_address_value N/A
ip_address property ip_address property N/A
name TeplpAddress [AddliPAddress
ip_netmask SubnetMask |Addisubnet
/Configurationitem/InfrastructureElement/NodeElement/Interface ard c 300 100) 100
mac_address PhysAddress [AddiMacaddress
name N/A |AddIMacAddress
/configurationitem/Infrastructuretlement/NodeElement/CPU N/A | Computer/CPU 300 100] 100}
name CpuName
cpu_id CpuiD
cpu_clock_speed CpuClockSpeed
/Configurationitem/InfrastructureElemer i i N/A |Computer/disk.device 300| 100| 100)
name DiskName
model_name
vendor DiskVendor
/Configurationitem/InfrastructureElemer ileSy IN/A Computer/file.system 300| 100 100]
disk_size Disksize
mount_point MountPoint
il _type FilesystemType
disk_type DiskType
/configurationitem/Infrastructureglement/RunningSoftware Running Software (777) 300 200}
discovered_product_name Clidentifier
[ ApplicationName
ProductVersion
[Vendor
version

Cl Reconciliation Priority

One of the challenges of managing an asset in its lifecycle phase as an active Cl is to have as
much information on it as possible collected from various systems—in addition to Discovery (such
as business-related information}—but at the same time prevent duplication in the CMS system and,
most importantly, keep the data's integrity. For these reasons, UCMDB holds the reconciliation
capability and, in addition, allows the Configuration Manager to set priorities for the various sources
of Cls.

In the SACM Solution, we have three sources — AM, SM and DDM. As part of the Solution’s
assets, there are Best Practices guidelines on how to set the Reconciliation Priority between AM,
SMand DDM.
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To configure Cl Reconciliation Priority
1. Logonto UCMDB as an administrator.

2. From the left-hand navigation pane, select Data Flow Management > Reconciliation
Priority.

3. Inthe Cl Types pane, in the Managed Object tree, select the relevant Cl type.

4. Inthe Cl Type Overrides pane, select the integration name you wish to change the priority
value for and click the Priority field to modify the value.

Repeat this step for every Integration Name you wish to change the Priority value for.
5. When the changes for the Cl types are complete, click the Save button in the Cl Types
pane.
To set the priority for a specific attribute for a particular CI type:

1. Select the relevant integration name in the Cl Type Overrides pane.

2. Inthe Attribute Overrides pane, click the Add %4 button. The Add Attribute dialog box is
displayed.

3. Select the relevant Attribute from list and click OK. The selected CI Attribute appears in
Attribute Overrides pane.

4. Modify the Priority value.

Note: If you add the wrong attribute to the list, use the Reset Attribute 9 button to reset
the Attribute Overrides list. Be aware this action clears all values in the Attribute
Overrides list.

5. When finished with the changes to that Cl type, click the Save button in the Cl Types
pane.
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This Appendix includes:

OV BIVIBW . 66
HP Asset Manager > HP Universal CMDB . ... e 66
HP Service Manager <-> HP Asset Manager ... . 82
HP Service Manager > HP Universal CMDB ... .. . ... i, 92

Overview

This appendix explains, for each database involved in the SACM integration, which data objects are
sourced and mapped by which scenario or adapter, as well as the reconciliation keys used and any
special requirements needed for data transfers to work properly.

HP Asset Manager > HP Universal CMDB

This section includes:

What ClI data are populated from AMto UCMDB? .. ... e 67
What is created in UCMDB during population? ... ... 71
ReconCiliation ... ... ... e 72
What happens when changes occurin AM during data population? ... .. ... ................. 72
Supported Cl TYPeS .. 72
Supported Cl attributes and the mapping with the AM fields ... .. ... ... 73
The configuration files used by the integration ... ... .. 78
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What Cl data are populated from AM to UCMDB?

This section includes:

Population TQLS 67

Criteria for AM records to be propagated ... . ... 68

Population TQLs

The types of Cls that can be propagated from AM to UCMDB are defined by the following TQLs
included in the integration package.

locationDatalmport_930

This query is used to populate location data from AM.
hostlmport_930

This query is used to populate computer data from AM.
networkimport_930

This query is used to populate network data from AM.
printerimport_930

This query is used to populate printer data from AM.
businessElementDatalmport_930

This query is used to populate business service assets from AM.
businessElementRelationsImport_930

This query is used to build relations between business service assets.

Note: For actual steps required to populate Cl data, refer to Creating an integration point
between AM and UCMDB [for details, see "Step 5: Create an integration point" on page 39]
and Running population jobs [for details, see "Verify UCMDB to AM Configuration" on page
41]. Also make sure that you have configured data population and federation as instructed in
Chapter 3 "Populating HP Universal CMDB from HP Asset Manager" on page 36].

To access these TQLs:

1.

Open a browser and connect to the UCMDB Server.

2. Click the Modeling tab.
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3. Select Modeling Studio.
4. Click the Resources tab, and select Queries from the Resource Type drop-down list.
5. Expand the Root/Integration/AM Data In menu. The TQLs located under the path are used to

manage CI data synchronization from AM to UCMDB. They have the same structure but
manage different type of Cl data.

Criteria for AM records to be propagated

Step 1: Node Cls

Node Cls in UCMDB correspond to records in the amComputer table in AM.

Out-of-the-box, the amComputer records need to satisfy the following conditions to be propagated
to UCMDB as Node Cls:

o The status for the Portfolio Item linked to the amComputer record is in use or in stock
(amPortfolio:seAssignment = In use or In stock).

This can be configured by modifying a configuration file (see "condition_rules.xml" on page 81.

o The amComputer:ComputerType field of the amComputer record must have a value that is
present in the third column of the following table.

Page 68 of 92



Configuration Guide
Technical Reference

Relationship between TQL, Cl Types, and computer types

Note: The path populates Cls of these Cl Types to UCMDB under Managed

Objects/Configurationltem/ InfrastructureElement/Node/

Populates Cls of these Cl Types
This TQL to UCMDB

hostDatalmport_930 Computer

ComputenWindows

Computer\Unix

Computer\Mainframe

networkDatalmport_ 930 Net Device\Firewall
Net Device\Router

Net Device\Switch

The CI Type corresponds
to these computer types in
AM (
amComputer:ComputerTyp
e)

Computer

Desktop computers
Computer servers
Laptop

Virtual Machine
Windows computer
Windows desktop computer
VMware VirtualCenter
VMware ESX Server
Unix server computer
Unix desktop computer
Solaris Zone server
Mainframe

Storage Array
Mainframe CPC

Note: Storage Array is not a
computer type value. By
default, AM will handle those
records where
amNature.Name is Storage
Provider as Storage Array.

Firewall
Router

Switch
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Populates Cls of The CI Type corresponds to these
these CI Types to computer types in AM
This TQL UCMDB (amComputer:ComputerType)

networkDatalmport_ 930  Net Device\ATM ATM switch
Switch

Node:

ADSL Modem
Appletalk Gateway
Bandwidth Manager
Cable modem
CSuU_DSU
Ethernet

FDDI

HUB

KVM Switch

Load Balancer

Multicast Enabled
Router

NAT Router
Token Ring

Undefined Network
Component

VolP Gateway
VolP Switch
VPN Gateway

Wireless Access
Point,

Frame_relay_switch
San_gateway
San_router
San_switch
Pad_handhel

printerDatalmport_930 Net Device\Net Network printer
Printer
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Note: In addition to the Node Cls, each of the TQLs also populates information (if exists) such
as IP addess, interface, and locations from AM to UCMDB.

e The mapping between Cl Type and computer type (value of the
amComputer:ComputerType field) is defined in the discriminator.properties file (see
"discriminator.properties" on page 78).

Step 2: Business Element

In AM, only those business service asset whose status (amAsset.Status) in the list of built,
catalogued, chartered, designed and requested will be populated to UCMDB. If the status is
retired, it will be removed from UCMDB.

Relationship between AM business service asset and Cl types:

Nature code Cl Type

BIZSVC business_service
BIZAPP business_application
INFRASVC infrastructure_service

What is created in UCMDB during population?
When an amComputer record (with the associated information) is populated from AM to UCMDB:
¢ ANode Clis created in UCMDB.
Its Cl Type depends on the value of the amComputer:ComputerType field.

= Relationship between TQL, Cl Types, and computer types (see "What Cl data are populated
from AM to UCMDB?" on page 67)

o Foreach Networkcard record (amComputer:NetworkCards) attached to the AM Node ClI, two
Cls are created in UCMDB: IP address and Interface.

The values of the following AM amNetworkCard table field are used to create the IPaddress
and Interface Cls:

= amNetworkCard:TcplpAddress, together with other field values, is used to create an IP
Address CI.

= amNetworkCard:PhysAddress, together with other field values, is used to create an
Interface CI.

« If the AM amComputer data has an associated location which is comprised of several layers,
then one Location Cl is created for each layer of location.

Page 71 of 92



Configuration Guide
Technical Reference

For example, in AM one computer has a location of /Ariane Building/31st Floor/030 — Office/,
then when the Node CI for the computer is populated to UCMDB, 3 location Cls are created for
each layer in the location, representing the building, floor and room respectively.

Note: The layers of location in AM should be less than the layer defined in the TQL, which
by default is 3. Otherwise, you need to add elements to the corresponding TQL to support it.

Reconciliation

For each Cl Type, the data reconciliation is governed by the reconciliation rule set in UCMDB.

You can check the reconciliation rule for each Cl Type on the Details tab of the Cl Type. The field
name is Identification.

What happens when changes occur in AM during data
population?

o If the value of the amPortfolio:seAssignment field has been changed to a value not present in
condition.rules.xml (see "condition_rules.xml" on page 81), the corresponding Cl is deleted from
UCMDB with the associated IPAddress Cls (if exists).

o However, if the IT equipment record is deleted from AM, the previously populated Cl remains in
UCMDB.

Supported Cl Types

To find out the Cl Types supported by the AM adapter out-of-the-box:

1. Start UCMDB Server.

2. Open a browser and connect to UCMDB Server as administrator.

3. From the left navigation bar, click the Data Flow Management tab.

4. Click Integration Studio.

5. Select the integration point created for AM.

6. Select the Federation tab on the right pane. The supported Cl Types are shown in the
5

Supported and Selected Cl Types section. You can click Expand all in the toolbar to

view all Cl Types at a glance.

Note:
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= Most Cl Types supported by the integration are UDM compliant, except for Printer and

those Cl Types under Node.
= Those grayed Cl Types are not supported.

» If aCl Type is supported, all its children Cl Types are automatically supported.

Supported Cl attributes and the mapping with the AM

fields

For each CI Type supported by the integration, below are the mappings between the UCMDB CI
attribute and AM field. For each CI attribute, its compliance with BTO Data Model (UDM) 1.1 is also

identified.

This section includes:

Gl TyPe: ASSOE .. 73
Gl Type: IpAAAresS ol 74
ClType: NOQe . 74
ClType: CPU oL 75
ClType: DISKDEVICE ... .. 76
Cl Type: FileSystem .. 76
Cl Type: InstalledSoftware ... ... .. .. 76
ClType: Interface ...l 76
Cl Type: LogicalVolume .. 77
ClType: Printer 77
Cl Type: Location .. 77
Cl Type: BusinessElement ... . ... . . 77

Cl Type: Asset

UCMDB attribute
asset_tag
description

id1

assignment

AM field
amPortfolio.asset_tag
amAsset.AssetSerialNo
amPortfolio.IPortfolioltemlId

amPortfolio.seAssignment

UDM entity?
Yes

Yes

No

Yes
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Cl Type: IpAddress

UCMDB attribute

id1

ip_address

ip_address_property

ip_address_value

ip_dhcpdomainname

ip_isdhcp

ip_netmask

name

Cl Type: Node

AM field

amNetworkCard.INetworkCardld
amNetworkCard. TcplpAddress
View_amNetworkCard.ip_address_property
View_amNetworkCard.ip_address_value
amNetworkCard.DHCPServer
amNetworkCard.BDHCPEnabled
amNetworkCard.SubnetMask

amNetworkCard. TcplpAddress

UDM entity?
No

No

Yes

Yes

No

No

No

Yes

All the children Cls of the Node ClI inherit the same attribute from the Node CI. In particular these CI
Types are relevant with the integration:

Computer
Windows
Unix
Mainframe
Firewall
Router
Switch
ATM Switch

Net Printer

UCMDB attribute

asset_tag

create_time

data_externalid

AM field
amPortfolio.AssetTag
amPortfolio.dtRecCreation

amComputer.IComputerld

UDM entity?
Yes
Yes

No
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UCMDB attribute

data_note

default_gateway_ip_address

description

discovered_os_name

discovered os_version

host_isdesktop
host_isvirtual

id1
last_modified time
memory_size
name

node_model
node_role
primary_dns_name
serial_number

globalid

Cl Type: CPU

UCMDB attribute
core_number
cpu_id

cpu_speed

id1

name

cpu_clock_speed

AM field
amPortfolio.seAssignment
amNetworkCard.DefaultGateway
amAsset.Description
amComputer.OperatingSystem
amComputer.OSServicelevel
amComputer.ComputerType
amComputer.ComputerType
amComputer.lltemld
amComputer.dtLastModif
amComputer.IMemorySizeMb
amComputer. TcplpHostName
amModel.ModelName
amComputer.ComputerType
amComputer. TcplpDomain
amAsset.SerialNo

amPortfolio. CMDBId

AM field
amComputer.ICPUCoreNumber
amComputer.IComputerld
amComputer.ICPUSpeedMHz
amComputer.lltemld
amComputer.Name

amComputer.ICPUSpeedMHz

UDM entity?

No

Yes
Yes
Yes
Yes
No

No

No

Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

UDM entity?

No
Yes
No
No
Yes

Yes
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Cl Type: DiskDevice

UCMDB attribute AM field UDM entity?
Id1 amPhysicalDrive.|PhysDriveld No
name amPhysicalDrive.Description Yes

Cl Type: FileSystem

UCMDB attribute AM field UDM entity?
disk_size amPhysicalDrive.|TotalSizeMb No

[d1 amPhysicalDrive.|PhysDriveld No

name amPhysicalDrive.Description Yes

Cl Type: InstalledSoftware

UCMDB attribute AM field UDM entity?
description Model.comment.memComment Yes
File_system_path amSoftinstall.Folder Yes

id1 amSoftinstall.ISoftInstld No

Name amModel.Name Yes

Vendor amBrand.Name Yes

Version amSoftinstall.VersionLevel Yes

CIl Type: Interface

UCMDB attribute AM field UDM entity?
id1 amNetworkCard.INetworkCardld No
interface_description amNetworkCard.Description Yes
mac_address amNetworkCard.PhysAddress Yes
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Cl Type: LogicalVolume

UCMDB attribute
id1
logicalvolume_free
logicalvolume_fstype
logicalvolume_size

Name

Cl Type: Printer

UCMDB attribute
id1

name

Cl Type: Location

UCMDB attribute
id1

location_type
name

Location_bar_code

AM field
amLogicalDrive.lLogDriveld
amLogicalDrive.IFreeSpaceMb
amLogicalDrive.Media
amLogicalDrive.|TotalSizeMb

amLogicalDrive.MountPoint

AM field
amPortfolio.IPortfolioltemId

amPortfolio.ModelName

AM field
amLocation.ILocald
amLocation.LocationType
amLocation.FullName

amlLocation.BarCode

Cl Type: BusinessElement

UCMDB attribute
Id1

Name
last_modified_time
create_time
description
data_note

global_id

AM field

amPortfolio. IPortfolioltemId
amAsset.AssetTag
amPortfolio.dtLastModif
amPortfolio.dtRecCreation
amAsset.Description
amAsset.Status

amPortfolio. CMDBId

UDM entity?
No
No
No
No

Yes

UDM entity?
No

Yes

UDM entity?
No

Yes

Yes

Yes

UDM entity?
No

Yes

Yes

Yes

Yes

No

Yes
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The configuration files used by the integration

This section includes:

Where are the configuration files located . ... ... .. 78
Where are the configuration files located

The configuration files that are relevant with the integration are located in the following path in

UCMDB:

Data Flow Management\Adapter Management\AMAdapter\Configuration Files

This section includes:
discriminator. properties ... ...l 78
server_desktop_distinguisher.properties ... ... 79
fixed values.tXt .. 80
location_type transformer.Xml . 80
condition_rules. Xml .. 81
Global_id_mapping.properties ... ... .. 82

discriminator.properties

When a Cl is populated to UCMDB, its Cl Type is defined according to the value of
amComputer:ComputerType in AM.

This file defines the mapping between the values of amComputer:ComputerType and the
UCMDB ClI Type.

A summary of the mapping can be found at the following location: "What Cl data are populated from
AM to UCMDB?" on page 67.

server_virtual_distinguisher.properties

When a Cl is populated to UCMDB, the Host is Virtual attribute of the Cl is defined according to
the value of amComputer:ComputerType for the Cl in AM.
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This file defines the mapping between the values of amComputer:ComputerType and the Host is
Virtual attribute.

If the value of amComputer:ComputerType in

AMis...

Virtual Machine

Windows computer
Windows desktop computer
VMware Virtual Center
VMware ESX server
Unix server computer
Unix desktop computer
Solaris Zone Server
Desktop computers
Computer servers
Laptop

Mainframe

ATM switch

Firewall

Router

Switch

Network printer

the value of Host is Virtual in UCMDB
is...

Virtual Machine

No

server_desktop_distinguisher.properties

When a Cl is populated to UCMDB, the Host is Desktop attribute of the Cl is defined according to
the value of amComputer:ComputerType for the Cl in AM.
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This file defines the mapping between the values of amComputer:ComputerType and the Host is

Desktop attribute.

If the value of amComputer:ComputerType in
AM is...

o Windows desktop computer
o Unix desktop computer

o Desktop computers

o Windows computer
¢ VMware Virtual Center
o VMware ESX server
o Unix server computer
e Solaris Zone Server
o Computer servers

o Laptop

¢ Mainframe

e ATM switch

o Firewall

¢ Router

e Switch

Network printer

fixed_values.txt

the value of Host is Desktop in
UCMDB is...

Yes

No

When populating IP address data from AM to UCMDB, the IpAddress:routing_domain attribute
value of the IP Address CI Type is populated with DefaultDomain.

This file allows you to change the default value for the attribute.

location_type_transformer.xml

This file contains all the mappings between location types in AM and UCMDB. Mapping for a

location type is represented by an entry like this:

|qva 1ue cmdb-walue=troom! external -db-value="room" /=
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The UCDMB location type is the value for the cmdb-value attribute, while the AM location type is
the value for the external-db-value attribute.

All the AM location types must be mapped with those in UCMDB for the data population to be
successful.

condition_rules.xml|

Out-of-the-box, this file defines the basic rules to decide what kind of Cls can be populated from AM
to UCMDB and remove Cls from UCMDB.

Out-of-the-box, only amComputer records whose associated Portfolio Item is in stock
(amPortfolio:seAssignment = In stock) can be populated to UCMDB as Node Cls.

This file allows you to customize the assignments (amPortfolio:seAssignment) computers could
have for them to be populated.

This configuration file uses values stored in the AM database to designate the value of the
seAssignment field. Refer to the following table for the relationship between the value stored in the
database and the displayed value.

Value stored in the displayed Actual displayed text for seAssignment
0 Inuse

1 In stock

2 Retired

3 Awaiting receipt

4 Return for maintenance

5 Return to supplier

6 Missing

You can designate multiple values in this file to allow populating computers with different
assignments to UCMDB.

Find the statement:

<expression join="AND" field="data_note" data-type="INTEGER" operator="IN" v
alue="0,1"/>

This means it will only add/update those Node Cls whose data_note (amPortfolio.seAssignment) is
0 (Inuse)or 1 (In stock).

Find the statement:

<expression join="NOT" field="data_note" data-type="INTEGER" operator="IN"
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value="0,1"/>
This means it will only remove those Node Cls whose data_note is not in the list of 0 and 1.
Note: Keep the same value for these two expressions.

This means that computers with the assignments (amPortfolio:seAssignment) In use and In
stock can be populated to UCMDB. If you change their assignment to other values in AM, the
corresponding Cls will be deleted when you run the population job next time (see "What happens
when changes occur in AM during data population?" on page 72).

Global_id_mapping.properties

Make sure Push back ID is enabled when creating the integration point. Define how to write
global_id back to AM. By default, global_id is saved in the amPortfolio. CMDBId field.

HP Service Manager <-> HP Asset Manager

This section includes:

OV IV W . 82
What happens when a Cl does not existin SM ... ... 83
Reconciliation keys foramsm-ppt.scn ... .. 84
Reconciliation keys foramsm-ci-ppt-link.scn .. 86
Reconciliation keys for smam-ppt.scn .. ... 87
Reconciliation keys for smam-Wo.SCN ... . 91

Overview

Overview of the HP Asset Manager — HP Service Manager integration

Integration

direction From AM to SM From SM to AM
Integration HP Connect-It HP Connect-It
technology
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Integration
direction From AM to SM From SM to AM
Populated e amsm-ppt.scn: e smam-ppt.scn:
data
» Companies » Companies
= Vendors = Vendors
= Locations = Locations
= Departments = Departments
= Contacts = Contacts
= Models = Models
= Stock rooms = Stock rooms
» Links between Cls and Contact, Model, e Smam-wo.scn:
Vendor, Location, Department
= Changes and
e amsm-ci-ppt-link.scn tasks
» Links between Cls and Contact, Model,
Vendor, Location, Department
HP Connect- e amsm-ppt.scn e smam-ppt.scn
It scenarios

e amsm-ci-pptlink. scn e SMam-wo.scn

Note: These scenarios do not create Cls. Cls are created in AM directly or created in HP
Discovery and Dependency Mapping Inventory and populated in AM.

AM Cls are populated/federated to UCMDB.
UCMDB Cls are populated to SM.

What happens when a Cl does not exist in SM

If a Cl does not exist in SM yet when a PPT/CI link is presented, an AM output event is created by
the HP Connect-It scenarios.

HP Connect-It will try and process the output events whenever the scenario is rerun.

Note that output events automatically expire according to the AM database options:
1. Start the AM Windows client and connect to the database.

2. Use the Administration/ Database options... menu.
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3. Configure the Event management/ Expiration time for output events (hours) option.

Reconciliation keys for amsm-ppt.scn

This section includes:

COMPANIES . . . 84
N ONUOIS .. ... 84
LOCatioNS il 84
DepatMENtS . .. 85
CONtaCS 86
MOl . 86
StOCK FOOMIS ... 86
Companies
Key in SM AM value searched for in the SM key
company:customer.id amCompany.Code

Only AM companies for which amCompany.Qualif1 = Parent company are replicated.

For languages other than English, the <HP Connect-It installation
folder>\config\ac\strings\qualif.str file must be customized. The ID of the string to modify in this file
is AMQUALIF_PARENT. Replace Parent company with the right string for your language.

The AM amCompany:Code field must be populated.

Vendors
Key in SM AM value searched for in the SM key
vendor:vendor amCompany.Name
AND vendor:location amCompany.MainSite:Barcode
Locations
Key in SM AM value searched for in the SM key
location:location amLocation.BarCode

The AM amLocation.BarCode field must be populated.
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Departments

Key in SM

dept:company +
dept:dept

AM value searched for in the SM key

amEmplDept.Location.Company.Code Reconciliation uses the following

rule:

RetVal = RemoveSlashAtExtremity([FullName])
If [Location.Company.Code] <> "" Then

RetVal = [Location.Company.Code] & "/"

& RetVal

End If

Example:

In AM, we have four departments:

Department NameA

FullName = /NameA/
o Department NameB under NameA
FullName = /NameA/NameB/
o Department NameC under NameB
FullName = /NameA/NameB/NameC/
o Department NameD under NameC
FullName = /NameA/NameB/NameC/NameD/

NameD is linked to a location linked to a company with
amCompany.Code = COMPANY_CODE SM.

The key for NameD is COMPANY _
CODE/NameA/NameB/NameC/NameD.

The key for NameC is NameA/NameB/NameC.

Only AM departments for which amEmplDept.bDepartment = 1 are replicated.
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Contacts

Key in SM AM value searched for in the SM key

contacts:contact.name  amEmplDept.Name, Name.FirstName (amEmplDept.BarCode)

Note:

o amEmplDept:Name can be up to 50 characters long, Name:FirstName up to 30
characters, and amEmplDept.BarCode up to 255 characters long.

e contacts.contact.name can only store 140 characters.

o Ifthe amEmplDept.BarCode field does not exceed 55 characters, the reconciliation keys

work fine.
Models
Key in SM AM value searched for in the SM key
model:part.no amModels.BarCode

Note: The AM amModels.BarCode field must be populated.

Stock rooms
Key in SM AM value searched for in the SM key
stockroom:stockroom amStock.Name

Reconciliation keys for amsm-ci-ppt-link.scn

This section includes:

Links between device Cls and PPT objects ... .. . ... .. 86
Links between device Cls and PPT objects

Key in SM AM value searched for in the SM key

device:asset.tag amComputer.AssetTag

Page 86 of 92



Configuration Guide
Technical Reference

Key in SM

Devices are linked to the
following objects:

o Contact

Model

Vendor

e Location

Department

AM value searched for in the SM key

The same keys are used as for the transfer of PPTs
themselves. See tables above.

The AM amComputer:AssetTag field must be populated.

Reconciliation keys for smam-ppt.scn

This section includes:

Locations and their link to a company and acountry ... .. 87
COMIPANIES il 88
SM Companies replicated as AM departments ... .. 88
Departments .. 88
CONtaCtS | 89
(001 -1 (o] £ T 89
N ONUO S il 89
SM vendor sites replicated as companies in AM .. 90
S OCKS . 91
MOdElS 91

The smam-ppt.scn scenario uses the SACMIntegration web service.

Locations and their link to a company and a country

Key in AM
amLocation.BarCode
amCompany.Code

amLocation.Country.Name

SM value searched for in the AM key
location:location
location:company

location:country
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If no country can be found for which amCompany:Code = location:country, the location will be
linked to a location with amCompany:Code = Unknown country.

Make sure the AM amCompany:Code field is populated.
Make sure the AM amCountry:Name field is populated with unique values.

smam-ppt.scn uses the ScCountryToAc map table in the catmod.mpt file to map SM countries to
AM countries.

Companies
Key in AM SM value searched for in the AM key
amCompany.Code company:CompanyCode
amCompany.MainSite.Name company:CompanyCode
amCompany.Sites.Name company:CompanyCode

Make sure the AM amCompany.CompanyCode field is populated with unique values.

Make sure the AM amCompany.Code field is populated.

SM Companies replicated as AM departments

Key in AM SM value searched for in the AM key
amEmplDept.BarCode company:CompanyCode
amEmplDept.Location.FullName company:CompanyCode

Make sure the SM amCompany.CompanyCode field is populated with unique values.

amEmplDept.bDepartmentis set to 1.

Departments
Key in AM SM value searched for in the AM key
amEmplDept.FullName dept:dept.structure

amEmplDept.bDepartmentis set to 1.

A function converts dept:dept.structure to amEmpliDept.FullName.
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Contacts
Key in AM SM value searched for in the AM key
amEmplDept.BarCode contacts:contactname
amEmplDept.Location.BarCode contacts:location
amEmplDept.Parent.FullName contacts:dept

Make sure the SM contacts:locationcode field is populated with unique values.

Operators
Key in AM SM value searched for in the AM key
amEmplDept.BarCode operator:name

amEmplDept.WorkUnit.Description = operator:name

amEmplDept.WorkUnit.Model.Name = The scenario links the employee to the model for which
amModel.Name = Hourly rate
Operators is an extension of the contacts table.
After contacts have been imported, operators are imported to populate amEmplDept.WorkUnit.
A model is created in AM with amModel.Name = Hourly rate.

This model is linked to a nature (which must pre-exist) with amNature.Code = TCO_WORK _
UNIT and also linked to a parent model which amModel.Name = Work unit and which will be
created if it does not exist.

The parent model must also be linked to a similar nature.

This must be created by hand or can be retrieved through the import of Financials — Line-of-
business data (TCO-budgets-chargeback).

Vendors
SM value searched for in the AM
Key in AM key
amCompany.Name vendor:vendor
amCompany.MainSite.FullName vendor:vendor.id +
vendor:vendor.location
amCompany.MainSite.Country.Name vendor:country
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SM value searched for in the AM
Key in AM key

amCompany.Contact.FirstName + amCompany. e vendor:contract.person
Contact.Name
e vendor:order.person

o vendor:sales.mgr

e vendor:service

Make sure vendor:contract.person, vendor:order.person, vendor:sales.mgr and
vendor:service use the <Last name>, <First name> format.

This is splitinto amCompany.Contact.FirstName and amCompany.Contact.Name in AM.

Make sure the SM vendor:vendor field is populated with unique values. If two different SM
vendors have the same value for the vendor:vendor field in SM in different locations, only the first
vendor is imported to AM.

Make sure the SM vendor:vendor.location + vendor:vendor.id fields are populated with unique
values. If two SM vendors have the same value for the vendor:vendor.location field and for the
vendor:vendor.id field although they are linked to different locations (address differs), the two
vendors will be linked to the same location (the first that was transferred to AM)

Make sure the AM amCountry.Name field is populated with unique values.

The HP Connect-It scenario uses the ScCountryToAc map table in the catmod.mpt file to map
amCountry.Name.

SM vendor sites replicated as companies in AM

Key in AM SM value searched for in the AM key
amLocation.FullName vendor:vendor.id + vendor:location are used to create a full
name

amLocation.Company.Name vendor;vendor

Make sure the SM vendor:vendor.id + vendor:location fields are populated with unique values. If
two SM vendors have the same value for the vendor:vendor.id + vendor:location fields although
they are linked to different locations (address differs), the two vendors locations will result in a
single location in AM (the first that was transferred to AM)

When vendors were created (see "Vendors" on the previous page), if two different SM vendors have
the same value for the vendor:vendor field in SM in different locations, only the first vendor is
imported to AM. So when the location created by this mapping is linked to a company, it may be
associated to the wrong company.
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Stocks

Key in AM SM value searched for in the AM key

amStocks.Name stockRoom:stockroom
amStock.Supervisor.BarCode stockRoom:manager

amStock.DelivLocation.Field1 location:location

Models

Key in AM
amModel.BarCode

amModel.Brand.Name

SM value searched for in the AM key
model:part.no

model:manufacturer

+
amModel.Brand.Com-
model:manufacturer

pany.Name
amModel.Nature.Code = model:Category

amModel.Parent.BarC = model:Category

ode

amModel.Photo if
[RetrieveSACMModelResponse.model.instance.attachments.att
achment(@).name] = "" then RetVal =
[RetrieveSACMModelResponse.mod el.instance.Model] + "_" +

[RetrieveSAC MModelResponse.model.instance.PartNumber]
else RetVal = "SM_" & [RetrieveSACMModelResp
onse.model.instance.attachments.attachment(@).name] end
if

amModel.Nature.Code is mapped using the ScToAcNature map table located in <HP Connect-It
installation folder>\scenario\ac\ac53\sacm\mpt\catmod.mpt.

The natures listed in the ScToAcNature map table must exist in the AM database.

A model is not created in AM unless at least one of following is populated in SM: model:Model,
model:PartNumber, model:Category.

Reconciliation keys for smam-wo.scn

This section includes:

Changes > Workorders . il 92
Tasks > Workorders ... L 92
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Forthe corresponding Cl ... ... L 92
This scenario propagates details of unplanned changes and tasks from SM to AM as Work Orders.

The relevant links between Cls and PPT data are propagated from AM to SM by another HP
Connect-It scenario.

Changes > Workorders

Key in AM SM value searched for in the AM key

amWorkOrder.WoNo cm3r:header.number

Tasks > Workorders

Key in AM SM value searched for in the AM key

amWorkOrder.\WoNo cm3t:header.number

For the corresponding Cl

Key in AM SM value searched for in the AM key

amComputer.AssetTag device:logical.name

HP Service Manager > HP Universal CMDB

This section explains how SM retrieves actual state information about Cls.
Displaying the actual state of Cls is a standard SM feature.

The actual state reflects the real attributes of a Cl. Most of the time, these attributes will be
retrieved through AM, and then populated/federated to UCMDB.

To retrieve actual state data, SM calls a UCMDB Web service. This Web service calls TQLs. The
TQLs retrieve AM data through federation and replication.
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